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ALPHA OMEGA PRODUCTS
LIMITED WARRANTY

Alpha Omega LTD., warrants that their Products will be in good working order for a period
of one year* from the date of shipment from Alpha Omega. If the Product is not in good
working order, the Purchaser shall notify Alpha Omega or its authorized representative
promptly.

If the Product fails within the warranty period, Alpha Omega will provide parts and labor at
no additional cost, to repair or to replace, at its sole option, the necessary components of the
Product. The repair or replacement parts will be furnished on an exchange basis, and will be
either reconditioned or new. If the Product is not in good working order, the Purchaser’s
sole remedy shall be repair or replacement as set forth above.

This limited warranty does not include service to repair damage resulting from accident, disaster,
misuse, or modifications by parties other than Alpha Omega or its authorized representatives unless
granted by Alpha Omega. The postage, insurance, and shipping costs incurred in presenting or
shipping the Product or components for service are the responsibility of the Purchaser.

THE PURCHASER IS RESPONSIBLE FOR DETERMINING WHETHER THE
PRODUCT PURCHASED MEETS THE PURCHASER’S NEEDS. THE PURCHASER IS
RESPONSIBLE FOR THE USE OF THE PRODUCT AND FOR THE RESULTS OF ITS
USE. ALPHA OMEGA SELLS THEIR PRODUCTS “AS IS WITHOUT WARRANTY
OF ANY KIND, INCLUDING ANY EXPRESS OR IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE WITH THE
EXCEPTION OF THE EXPRESS TWO YEAR LIMITED WARRANTY MENTIONED
ABOVE. IN NO EVENT SHALL ALPHA OMEGA LTD., BELIABLE FOR ANY LOSS,
INCONVENIENCE, OR DAMAGES, WHETHER DIRECT, INCIDENTAL OR
CONSEQUENTIAL, ARISING OUT OF THE USE OF, OR INABILITY OF USE, THE
PRODUCT.
THE PURCHASER ASSUMES THE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PRODUCT. SHOULD THE PRODUCT PURCHASED
PROVE TO BE DEFECTIVE, THE PURCHASER, AND NOT ALPHA OMEGA, SHALL
ASSUME THE ENTIRE COST OF ALL-NECESSARY REPAIRS, SERVICING, OR
CORRECTIONS, EXCEPT AS STATED ABOVE. ALPHA OMEGA DOES NOT
WARRANT THAT THE PRODUCTSWILL OPERATE WITHOUT DEFECTS.
SOFTWARE LICENSE
ALPHA OMEGA LICENSES THE SOFTWARE PROVIDED WITH THE PRODUCT
(EXCLUDING THE WINDOWS SOFTWARE) THAT IS CONTAINED IN READ ONLY
MEMORY (ROM) AND ON DISK, TO THE PURCHASER. THE PURCHASE MAY
NOT COPY THE SOFTWARE THAT ISIN ROM. THE PURCHASER MAY COPY THE
SOFTWARE THAT ISON DISK FOR BACKUP PURPOSES ONLY .
*Note: For those who purchased a computer from Alpha Omega: The computer and its software
have their own warranty which is not included in the two year warranty stated above.
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Preface

The M CP-Plus User's Manual provides all the information needed to install and
operate the M CP-Plus effectively. We recommend that the first-time user read
through the entire manual before operating the M CP-Plus.

The M CP-Plus User's Manual is divided into the following sections:

1. Introduction: This section provides an overview of M CP-Plus highlightsand it’s
operating environment, including diagrams of the M CP-Plus signa conditioning
system.

2. Installation: This section describes the installation procedure for the system’s
various modules.

3. Operation: This section provides detailed instructions on operating the M CP-
Plus.

4. Troubleshooting: This section presents solutions to possible problems that may
arise while operating the M CP- Plus.
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1 Introduction

1.1 General Description

The MCP- Plusisamodular amplification and filtering system designed to amplify
and filter amost any physiological analog input.

The MCP-Plusis available in two models:
1. MCP-Plus8 - anon-modular 8 channel Multi Channel Processor.

2. MCP-Plus - amodular Multi-Channel Processor, up to 256 channels, with a
minimum of 16 channels, channels can be added in multiples of 4.

Both models offer the same functions are offered for both systems, these include:

e Gain amplification

e ACand DC coupling

o Low passfiltering

o DClevel shifting

o Sine Generator for Impedance Measure of input electrode
The MCP- Plusis arack-mountable system that is controlled by a computer. Since
the signal conditioning and data acquisition software control all parameters there are
no manual controls on the front panel, eliminating the need to record or remember the
parameters setting. Parameters and setting are saved and set by the software

providing increased user convenience, especially when using alarge number of
channels.

The MCP-Plus consists of the following components:
o A chassisthat holds the different modules
o A linear power supply

e Control module

Analog I nput/Output modules

8 - 256 outputs (both modular and non-modular)
The MCP- Plus has up to 256 differential, low noise, inputs. Inputs can be sent
directly to the MCP, or they can be received from a Pre-amplifier or aHead Stage.

Each MCP channel has 2 outputs: afiltered output, and an "unfiltered" output that
can be used for further conditioning or for archiving.

The gain, filters and DC level shifting are controlled by the software and can be
easily adjusted on the PC screen and saved to disk.

A 2-pole Butterworth High-pass filter and a 4-pole Low-pass filter are provided and
can be controlled by the software.

The status of the M CP-Plus can always be read on the PC screen.

The M CP-Plus a so provides special functions that are useful for measuring
activities from the nervous system using extra cellular microelectrodes.
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The electrode’s impedance can be measured easily using the mouse, by clicking the
on/off impedance circle on the PC screen.

A stimulus option can be switched On/Off by using the mouse to click the on/off
stimulus control on the PC screen.

The MCP allows the user to control the electrode selection for current injection and
stimulus.

The M CP is equipped with DC floating power supplies that supply the DC voltages
to the MCP, and for Pre-amplifiers or for Head Stage units.

An RS232 link to the PC is provided to control the M CP viathe PC.
The MCP-Plusis designed for specific user defined configurations.

An external shut-off connector on the rear panel enables the user to shut off all
channels simultaneously.

The head stage control connector on the rear panel of each module may be used to
shut off each channdl individually.
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1.2 Featuresand Benefits

Up to 256 Modular Channels (el ectrodes)

High Impedance Differential Inputs

Filtered Outputs

Notch Filter (50-60Hz)

Unfiltered Outputs

Flexible Gain Selection

Flexible Filter Selection (2 and 4 pole Butterworth)
DC Leve Shifting

Electrode Impedance Measure per Module
External Stimulation On/Off switch

Head Stage Control per Module

Stimulus Control

Audio Mixer

Serial Communication (RS232) to PC
User-Friendly Software Package

Compatible with the MSD - Multi-Spike Detector and other standard data acquisition
systems.

Figurel: MCP-Plus Modular system Front Panel
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Figure 2: MCP-Plus Modular system Rear Panel

M CP-Plus Modular system - Identification of Parts

Hole for mounting the MCP-Plus on Rack
Fastening screw

BNC Output

Channel On/Off LED Indicator

Communication error LED Indicator

Power On/Off Switch

Control Lines Connector for cascading

Mains power receptacle, Line Filter, 110/220 Voltage control and fuses
Digital 1/O (stimulator control)

10. Digital I/O (Mixer control)

11. Serial RS232 connector for communication with PC
12. Control and DC power supply for PrecAmp

13. Input Connector

14. Output Connector

15. Ground Connectors

©CO~NOUDWNR
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MCP-Plus 8 - List of Parts

Hole for mounting the MCP-Plus on Rack

Power On/Off Switch

Power On Indicator

Channel On/Off LED Indicator

BNC Output

Output Connector

Input Connector

Control and DC power supply for Pre-Amp.

Audio Mixer input.

10. Audio Mixer output.

11. Digital Control 1/0 connector 1 (Audio Mix Control, External Stimulation On/Off switch)
12. Digital Control 1/O connector 2 (Stimulator control)

13. Serial RS232 connector for communication with PC

14. MCP+ Ground

15. Line Ground

16. Mains power receptacle, Line Filter, 110/220 Voltage control and fuses
17. & 18. Bus connectors, these connectors are for future use.

CONOO~WNE
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- Anaog I/0O modules
- Notch filter
- Control Module

- Linear power supply / Isolation transformer

1.3 MCP-Plus Technical Specifications

M CP-Plus modules and components:

- Linear power supply for Pre-amplifier or Head Stage

- Casing

- Power cord

- Communication software package
- Communication cable

Technical Specifications

Dynamic range

Input impedance
Frequency response
Noise (1 Hz- 10KHz BW)
Differential Inputs CMRR

DC level shifting (R.T.I)

Gain selection  (including HS gain, “X 257)
High pass (2 pole Butterworth)

Low pass (4 pole Butterworth)

Sine wave generator (for imp. measure)

RS232 (Serial Communication to PC)
Baud rate

Linear Power Supply

Line voltage

DC outputs

Housing

Rack mountable

T10v

IMQ || 2PF
DC- 10KHz
<10 4V RMS

110dB
+50uV to +3V
Up to 63,750
DC -1KHz
100Hz-10KHz

100mV, 1KHz

9600

100VAC, 60Hz 50Hz
110VAC, 60Hz or
220VAC, 50Hz

+12V, -12V, +5V

19"
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1.4 Differential input Head Stage -Technical Specifications

Dynamic Input range T1v

Dynamic Output range T1ov

Input impedance 100M Q

CMRR ~110dB

Freguency response DC - 10KHz

Noise (1 Hz- 10KHz BW) | <10V RMS

Gain 10

Supply 12V, 5V - Supplied from the MCP
Case dimensions 3" X 1" X 05" (75X 26 X 13 mm)
Weight 55 Grams
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2 |nstallation

2.1 General

The M CP-Plusis a signal-conditioning system that can receive 8 t0256 channels
from the input signal or from Pre-amplifiers or Head Stages via a cable, outputting
the processed signals to a system like the M SD or any other data acquisition system.

2.2 Installing the MCP-Plusin Rack

Mount the MCP-Plus on the rack by inserting screws into the holes on the sides of

the MCP-Plus.

2.3 The PreeAmplifier Head Stage

The Pre-Amplifier Head Stage, along with the MCP-Plus, makes a very low noise
and easy to install system that can accommodate all kinds of electrophysiological
labs. They are designed in away that they can be suited to the ground setup of the
lab. Installing the head stage Pre-Amplifier and connecting it to the subject animal
and to the MCP-Plus and to the ground is the most delicate part and should be done
by an expert who is familiar with handling low noise systems for measuring small
signas. If theinput source comes from a high impedance source, such asa
microelectrode that has a high impedance of several Mega Ohms, it makes it more
difficult to eliminate the noise, as the high impedance source works like an antenna
that might collect al kinds of surrounding noises. In addition to all the functions and
options supplied by the Head Stage Pre-Amplifier, it is recommended to shield the
area surrounding the place of recording with a good shielding to help eliminate

surrounding noises collected by the high impedance microel ectrode.

Stimulation
connector

Head stage pre-amps

Output connector
(to interface box)

4 channelsinputs
connectors
(to microelectrode)
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2.4 MCP-Plusand Pre-Amplifier Head Stage Connections

If the Head Stage Preamplifiers are purchased al ong with the MCP-Plus, an interface box &
two cables are supplied together with the pre-Amps. The preeampscanbe 1 0OR2O0R 3
OR 4 channédls, and connected to the interface box, with the short cable, then the interface
box is connected to the MCP with the long cable. The long cable connects between the M CP-
Plus and the interface box outputs. D-type 15 pin connectors terminate the cable. Plug the
designated M CP connector into the corresponding input located on the rear panel of the
MCP-Plus. Plug the designated HS connector to the interface box. Fasten the screws of the
D-type connectors to ensure good connections.

Since the connection carries the power supply to the Head Stage, it isimperative to
turn the power off before connecting the Head Stage, and the interface box.

Refer to ‘Connector Pin Assignment” (section 2.6) for a detailed description of the
pin assignment.

2.5 Ground Connections and Shielding

The Head Stage pre-amp has instrumentation (differential) input, which makesit
easier to overcome grounding problems. The Head Stage Pre-amp Box can handle up
to 4 Channels.

The Head Stage pre-amp channels have a common ground input connector (GND-
black connector) and a common minus input connector (In-), The In- of al the pre-
amps connected together (yellow connector).

The In- and GND should be connecting to the same reference point.

GND connections should be made so that no ground loops will be generated. The
user some times should play around with these connections until the best results are
achieved.

Tipsand recommendations:

- All systems used for measurement should be connected to the same electrical outlet
to minimize ground loops.

- The space in which the subject animal islocated should be shielded, preferably a
noise-free shielded room.

- Do not use any devices that operate on AC power, like 100,110 or 220VAC, in
close proximity to the (shielded) area.

- Do not use any device that transmits electromagnetic noise (e.g., amonitor) in close
proximity to the (shielded) area. If such devices are used, they should be shielded.

- Do not leave any unused unconnected inputs. These devices should be switched off
or connected to the ground.

MCP-Plus User ’'s Manual
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2.6 Head Stage & Interface Box Pin-out Connections
I nterface Box Output Connector (male)

00000000

OQ OlO Oll OlZO lBO 14O 15
1- NC
2- NC
3- KEY
4-  SineInput for Impedance measure
5-  Output 4
6-  Output 3
7-  Output 2
8  Output 1
9- VEE(-12V)
10- VCC (12v)
11- GND
12- GND
13- GND
14- GND
15- GND

Interface Box Input Connector (female)

‘00'bob0O O

15

00000 O0O0

14 13 12 11 10

CoNOUOAMWDNE

Input 1

Input 2

Input 3

Input 4

GND

Sine for Impedance measure
RELAY?2
RELAY4
GND

VCC (12V)
GND

-VEE (-12V)
GND
RELAY1
RELAY3

MCP-Plus User ’'s Manual

11



Head Stage Pre-Amp Output Connector

‘0°0’0'0’0°0'0°0
0000000

10 11 12 13 14 15

1. Input 1
2. Input 2
3. Input 3
4. Input 4
5. GND
6. Sine for Impedance measure
7. RELAY?2
8. RELAY4
9. GND
10. VCC (12V)
11. GND
12. -VEE (-12V)
13. GND
14. RELAY1
15. RELAY3

Head Stage | nstrumentation Pre-Amp Input Connector

1-  Input + (red connector labeled with channel number)
2-  GND (one black connector for all channels)
3-  Input - (one yellow connector for al channels)
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Head Stage Pre-Amp. , Interface box & M CP-Plus8

Interface Box

Head Stage Pre-Amp

MCP-Plus User 's Manual 13



Mixer & MCP-plus8

Mixer Box (Rear panel)

Mixer Box (Front panel)

Mixer output
to speaker

MCP-Plus User ’'s Manual
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2.7 M CP-Plus Pin-out Connections
M CP-Plus Output Connector (female)

8

O,

7

Q000OO0O0
5 O14 Ol3o 12O 11O 10O 9

1-
2-
3-
4-
5-
6-
7-
8-
0-
10-
11-
12-
13-
14-
15-

Filtered out 1
Filtered out 2
Filtered out 3
Filtered out 4
Unfiltered out 1
Unfiltered out 2
Unfiltered out 3
Unfiltered out 4
Anaog Ground
+12V

Anaog Ground
-12v

Digital Ground
+5V

Anaog Ground

M CP-Plus Input Connector (male)

oo O

10 11 12 13 14 15

Digital Ground
+5V

Anaog Ground
Sine Output
Input4 +

Input3 +

Input2 +

Inputl +

-12v

+12V

Anaog Ground
Input4 -

Input3 -

Input2 -

Inputl -
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M CP-Plus Control Connector on 1/O module (female)

M CP-Plus Digital

O00O0O0
9OBC)7OGO

Floating +12V for Pre-Amp H.S.
Floating Ground for Pre-Amp H.S.
Control line 1 (On/Off) output
Control line 3 (On/Off) output
+5V

Control 1/N output

Floating -12V for Pre-Amp H.S.
Control line 2 (On/Off) output
Control line 4 (On/Off) output

I/O 1 connector (female)

This connector is used to connect all the control signals and power to the Audio-Mix
“Electrode Stimulus Multiplexer”. This connector should be connected to the “Power
and Control” connector situated at the rear panel of the Audio-Mix.

10 11 12 13

0000000000000
000000000000

14 15

16 17 18 19 20 21 22 23 24 25

1 -INO
2 -IN2
3 -IN4
4 -|IN6
5- 0UT1
6 -0OUT3
7 -0OUT5
8 -OUT7
9 -+bV
10- +5V
11-VCC
12 - -VEE
13- ONOFF

14-IN1

15-1IN3

16-IN5
17-0UTO0

18- 0UT2
19-0UT4
20-0UT6

21 - Digital Ground
22 — Stimulation On/Off
23 - OPTN

24— AUD-CLK
25-EN
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M CP-Plus Digital 1/0 2 connector (female)

0O000000O0

15014O 13012011O lOO 9 O
1. RSl (RANGE SELECT1)
2. RSO (RANGE SELECTO)
3. CSPOT
4.  SD-IN (SEARIAL DATA INPUT)
5.  CLK-POT
6. GND
7. MAN-CON (MANUAL CONTROL MODE)
8.  STIM-ON/OFF
9.  SHDN-POT
10. STIM-BACK
11. AD1-BACK
12. ADO-BACK
13. VCC
14. GND
15. -VEE

RS232 Serial communication Connector to PC (male)

00000
0.0,0,0

NC

Transmit (TXD)
Receive (RXD)

Clear To Send (CTS)
Digital Ground

NC

NC

Ready To Send (RTS)
NC
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2.8 Power Cord Connection

Check that the MCP-Plus power switch is off. Verify that the linefilter sign
(100V/110V /220V) is compatible with the line voltage supplied. Then plug the
power cord's female plug into the electricity connector on the rear panel and plug the
male plug into the main power connection (wall socket).

2.9 Installing an Analog I/O Module Card

This section includes instruction for the installation of an additional analog I/0
module in an MCP-Plus system.

Counting from left to right, the output modules have addresses of 1 to 64 (e.g. the
first module has address 1; the second Module has address 2 etc.). The new module
card will beinstalled at the address N. Remove the blank front panel and the blank
rear panel of address N by removing the 2 fastening screws at the top and bottom of
the each panel. Check the module address in the dipswitch table. (Ref. to Output
Module Card Layout and the Analog I1/O Board Base Address dipswitch table). After
setting the dipswitches, insert the new Modulein the rear panel within the top and
bottom card guides and guide it carefully until it reaches the end and press firmly
until you feel that the connector is engaged. Fix in position using the two fastening
screws. Connect the 20-pin connector to the connector on the front panel using the
short flat cable supplied and fix in position using the two fastening screws. The new
Module is now positioned within the frame.

Note : To remove an analog I/O module, first unscrew the front panel and disconnect the 20
pin flat cable and then take out the module fromthe rear panel by unscrewing the
2 fastening screws, and pulling the module out.

Table 2-1 SW1 - Analog 1/0 Board Base Address Dip-Switch Set

SW1Dip 1 2 3 4 5 6 7 8 Address
switches
off on on on on on on on 1
on off on on on on on on 2
off off on on on on on on 3
on="0" on on off on on on on on 4
off ="1" off on off on on on on on 5
on off off on on on on on 6
off off off on on on on on 7
on on on off on on on on 8
off on on off on on on on 9
on off on off on on on on 10
off off on off on on on on 11
on on off off on on on on 12
off on off off on on on on 13
on off off off on on on on 14
off off off off on on on on 15
on on on on off on on on 16
off on on on off on on on 17
on off on on off on on on 18
off off on on off on on on 19
on on off on off on on on 20
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on="0

off ="1"
on="0"
off ="1"

off on off on off on on on 21
on off off on off on on on 22
off off off on off on on on 23
on on on off off on on on 24
off on on off off on on on 25
on off on off off on on on 26
off off on off off on on on 27
on on off off off on on on 28
off on off off off on on on 29
on off off off off on on on 30
off off off off off on on on 31
on on on on on off on on 32
off on on on on off on on 33
on | off on on on off on on 34
off | off on on on off on on 35
on on off on on off on on 36
off on off on on off on on 37
on | off off on on off on on 38
off | off off on on off on on 39
on on on off on off on on 40
off on on off on off on on 41
on | off on off on off on on 42
off off on off on off on on 43
on on off off on off on on 44
off on off off on off on on 45
on | off off off on off on on 46
off off off off on off on on 47
on on on on off off on on 48
off on on on off off on on 49
on | off on on off off on on 50
off off on on off off on on 51
on on off on off off on on 52
off on off on off off on on 53
on | off off on off off on on 54
off | off off on off off on on 55
on on on off off off on on 56
off on on off off off on on 57
on | off on off off off on on 58
off off on off off off on on 59
on on off off off off on on 60
off on off off off off on on 61
on | off off off off off on on 62
off off off off off off on on 63
on on on on on on off on 64
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2.10 Communication Installation

The PC Requirements
- IBM- AT or compatible that can run Windows 9x/2000/NT/XP
- Minimum 640KB RAM
- CD ROM Drive
- Hard Disk
- RS232 port
- Monitor SVGA

Hardware I nstallation

Connect the communication cable to the 9-pin D type male connector on the rear
panel of the M CP-Plus and to the serial communication card (RS232 port) on the
rear panel of the PC (either COM1 or COM?2).

Softwar e Installation
Insert the CD supplied into the CD ROM drive and run setup.
Follow the Installation instructions that appear on the screen.

At the end of the setup process the user is requested to enter the below values
according to the system purchased.

& Setup
Port: |2 - i
MHumber Modules: | 2
Modules in indow: | a

Click OK and then Finish to finalize the installation.

The installation program will create anew sub directory on the hard disk called
M CP-Plus, containing all the relevant files.
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3 Operation

3.1 General

The MCP-Plusis simple to operate. This section explains the principles that are
fundamental to the M CP-Plus and provides detailed operating instructions.

The operating procedure consists of the following steps:

a Make sure that the M CP-Plus is connected to the main power source, that the
serial communication cable is connected to the PC, and that the input cables
are properly connected.

b To turn on the M CP-Plus, turn on the power switch on the front panel.

All MCP-Plusinputs are differential with avery high CMRR (Common Mode
Rejection Ratio) that enables the user to use long input cable without affecting the
signal immunity to surrounding el ectromagnetic fields like line 50Hz or 60Hz.

3.2 Readytogo

Double click the M CP-Plusicon

The following window appears:

D=l & | Sia 2x|m|8 o

mCeF
FLUS

Mep.exe

& Mcp Windows Application - default. dat - [Module 1, Channel 17 [= [[B]3€]
[E e £ Wew Window Sefup Sstogr Hep

- O X

For Help, press Fl

LT

2151
ot @ OFF @
Gain: - Gaim: g2
He: [BE - Wi ]
5 2 —
ot E ot [0y |
1-2(2) 3-2(8)
Notch @ oN o Noleh @ OFF ®
D Era—
OSE [y ot [aoy |
1-3(3) 23N
Notch @ oN & Nowh @ OFF @
- [
D O —
OIsE o, Ot a3 o
1-4(4] 2-408)
Notch @ oH 5] Nowh @ oFF @
D T— U Cr—
ofst |4 oy O75E |3 v
L] Imped OFF & Imped.OFF |
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Channel On /Off
By clicking the On/Off field you can turn the desired channel on and off.

Warnings

A. In order to avoid noise problems perform one of the followings:

1. Incaseastimulator isconnected to the Head Stage -
ground all unused channels.

In casethereisno stimulator — turn unused channels off.

In casethereisno stimulator — for unused channels lower
thegain level to 0.

B. All channelsin a module should stay on if stimulation current is
injected into the Head Stage that belongsto this module. Turning
a channel off would inject the current into that electrode.

Notch Filter On /Off

Available only if “Notch Installed” box is checked during setup. Click the "Notch"
button to turn the Notch filter of the desired channel on and off.

Gain Sdlect

One out of possible 500 gains can be applied. The number shown in the gain display
can be set to include the gain of the pre amp. To change the gain amplification just
click the gain field and select the desired gain.

High and Low Pass Filters (HP and LP)

These two fields control the high pass and the low passfilters. The filters used are
Butterworth filters that have a very flat pass band response. The amplitude response
of thiskind of filter is:

1

2

Vout /Vin=1/[1+(f 1 10)*]* 115 (No. of poles)

The high passisa 2 pole variablefilter. The cutoff frequencies applied within the
high pass filter are from DC to 1Khz with 65 discrete frequencies. The low passisa4
pole variablefilter. The cutoff frequencies applied within the low pass filter are from
100Hz to 10khz with 57 discrete frequencies.

DC offset

It is possible to change the DC offset by clicking the offset field and selecting the
desired DC shift that can range from £50uV - £3V, with over 450 DC levels.

Microelectrode Impedance M easur e

The microel ectrode impedance measure field is usually off during normal operation.
When switched on, a sine wave generator (100 mV - scientific, 2V — medical version,
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1 kHz) is activated and connected to the cable going to the Head Stage. The outputs
from the Head Stage now give a sine wave of amplitude proportional to the
impedance of each microelectrode. These outputs are fed to the inputs of the M CP-
Plus. In this mode, the gain in all the Output Moduleis fixed to 1000(1000 is
optional), the high pass to 300Hz, the low pass to 5khz and the offset to zero
automatically. The user can now measure the voltage at the filtered outputsin the
selected Analog 1/0 Module. The microelectrode impedance can be calculated using
the following equation:

Z=Vo
where Z isthe microel ectrode impedance in Mega Ohms
and Vo isthe voltage measured at the spike outputsin Volts

When the user switches the Impedance Measure off, the sine wave generator is
deactivated and disconnected from the cable going to the Head Stage, and instead the
analog ground is reconnected. The gain, the Low and High Pass filters and the Offset
are also restored to their previous settings; i.e. settings existing before entering the
impedance measure mode.

3.3 Central Processing Unit

The central processing unit controls all parameters of gain and filters of the M CP-
Plus at start up and shut down. At start up, it recalls all parameters from the PC so
that the user is not required to reset the parameters.
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34 Usingthe Menu Options

“File” menu options:

New: Opens a new window (group of modules) if there is a closed one.

Open: Start adialog to open afile previously saved in the M CP-Plus.
Note: if the group of modules window was closed it can be re-opened
by using the “New” option (the “Open” option will not work).

Close: Closes the active windows (group of modules). The closed window
can be reopened by the new option.

Save: Save the parameter into the open file. If no file is opened, the PC
opens adiaog to enter the file name.

Save As. Open adialog to save the parametersinto a new file.

Print: Prints the parameter of all the fields of the M CP-Plus

Print Preview: Displaysthe data, asit will be printed.

Print Setup: Opensthe dialog for setting the printer options.

Exit: Exit the MCP-Plus program. If the parameters are not saved, the

program saves them into the file Default.dat at before exiting

“Edit” menu options:

Copy Field:

Copy Channel:

Copy Module:

Paste:

Paste M odule:

Paste All:

Copy the vaue of the currently selected field into the program’s
memory. This copied value can be pasted later in the same field of
any channel(s).

Copy the values of al the fieldsin the current channel into the
program’s memory in order to paste these values later in any
channel(s).

Copy the values of all thefield of all the channelsin the current
module (module is the 4 channels in one column on the screen. i.e.
channels 2-1, 2-2, 2-3 and 2-4 are the channels of module number 2).

Paste the last copied value(s). If the last copied value is onefield
(Copy Field command), then the paste command loads the val ue of
the copied field into the same field in the current channel. If the last
copy command was Copy Channel, the values of all the fields of the
copied channel are loaded into the field of the current channel. And if
the last copy command was Copy Module, the values of the copied
module are loaded into the current module.

Paste the last copied values into the current module. If the last copy
command was copy field, then the samefield of all channelsin the
current module is updated. If the last copy command was copy
channel, then the values of the copied channel are loaded to all the
channelsin the current module. And if the last copy command was
copy module, the values of the copied module are loaded into the
current module.

Pastes the last copied value(s) into al channels. If the last copy
command was copy field, then the samefield of all channelswill be
copied. If the last copy command was copy channel, then the values
of the copied channel are loaded to all the channels. And if the last
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copy command was copy module, the values of the copied module
areloaded into all the modules.

“View” menu options:

Toolbar: Display / hide the toolbar.

Statusbar: Display / hide the status bar.

Zoom Channel: Zoom in on current active channel.

Zoom All: Zoomin/ out. If the current display istoo tight (when more than 8

modules are displayed on the screen) use the Zoom command to
enlarge the size of each module. When in zoom, ascroll bar is
shown to enable the user to scroll between all the modulesin the
same window.

“Window” menu options:
Cascade: Arranges all opened windows (groups) in a cascaded (overlapping)
order.

Tile: Arrange al opened windows (groups) in averticaly tiled order.

Arrange | cons: Arrange al Minimized windows (groups) at the bottom of the
main M CP window.

Next Channel: Select the next channel. (F5)
Prev Channel: Select the previous channel. (SHIFT+F5)

Impedance:  Select the Impedance button of the current channel. Or, select back
the current channel. (F7)

Note: To select the next window (the next group of channels) pressthe F6 key, to select the
previous window, press CTRL+F6.

“Setup” menu options:

The Optionsdialog box:

MNurmber of modules {1 - 64} |2

Module in one window ; |2
Audio Installed: |Nl:|ne jv

[ Motch Installed
¥ lsalator Installed
v Stim/Fec Switch Installed

Cancel l

Specify the number of modules that are to be used and the number of modulesin one
window. Check the checkboxes according to the hardware installed on your system.
See Appendix B for more details regarding the Stim/Rec Switch.
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Select the audio device installed on the system. Check the Notch, Isolator and
Stim/Rec Switch boxes if installed.

To finalize setup click the OK button.

Enable/ Disable
Opens adialog for enabling or disabling a module. Once disabled, a module
is shown on the screen, but its field’s values can not be altered unlessit is
enabled first.

Serial COMM Number:
Opens adialog for changing the serial communication port number.
When the serial COMM number is changed, the PC attempts to open
the new COMM, and if successful, it generates a “conversation” with
the M CP-Plus. If the M CP-Plus responds, the communication is
started. If any error occurred, the PC will inform the user.

Change PreGain Value
Opens adiaog for changing the PreGain value.

The user can change the value for each channel by selecting one of
these options 1 or 25 or set other value in the edit box.

x
— Module 1
Channel Mo, PreGain Value
1 1 125 " Other
2 1 125 " Other
3 1 125 " Other
4 1 5  Other |
— Module 2
Channel Mo. PreGain Value
5 1 125 " Other
4 1 25 " Other
7 (Ol 25 " Other |
8 1 125 " Other I
—Module 3
Channel Mo. Prelain Yalue
g 1 o5 " Other I
10 1 25 " Other
1 (O L] " DOther
12 Lol 25 " Other
— Module 4
Channel Mo. PreGain Value
13 (O 25 " Other I
14 1 125 7 Other I
15 f* 25 " Other
16 1 oo Coother [
<< Prew Channels SetI Iext Channels Set >>|
Cancel | Apply I H i

Use the Prev Channels and Next Channels buttons to navigate
between channels.
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Impedance Gain Value
This option controls the Impedance Gain of the M CP-Plus. User can
change Gain of the output during impedance measure mode.

“Settings”’ menu options:

Stimulus
Open the Stimulus Control dialog box. In this dialog the user can
activate/deactivate the stimulus, and if activated, you can select the
stimulus and the stimulus return addresses.
Select: Select the channel of the
STIMULUS CONTROL stimulus
Return: Ground.
Select Stimulation Channel iil According to Stim/Rec Switch:
Bieturn Ground Check this box to inform the
™ According to Stim/Rec switch MCP that the Al pha Simulus

Isolator triggers the stimulation
externally (see Appendix B).
Start: Start stimulus.
Close | Start Stop Stop:  Stop stimulus.
Close: Closethedialog. If the stimulus
is active, the Close button will
deactivate the stimulus.

* Refer to Appendix A for information about the Alpha Stimulus I solator.

| solator
Open the Stimulus Isolator dialog box. In this dialog user can control
the Stimulus Isolator. Stimulus Isolator is an optional external device.
The user can select number of stimulated channel and the ratio of
conversion for output current.

Check the “According to Stim/Rec Switch” box to inform the MCP
that the Stim/Rec Switch triggers the stimulation externally.

Stimulus Isolator I
Contral : Auto O
Channel : R

Status ; Off @ |1
™ According to Stim/Rec switch

@& 100 micro

Y= |D.BmkA Liil 1 mA
10 ma,
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Audio Mixer

Open the Audio Mixer dialog box. In this dialog user can activate the
mixing of audio output from multiple channels.

Select | UnSelect |
Select All | UnSelect All|
— Channels:
Mame Module - Channel
__|Channel 1 1-1
__|Channel 2 1-2
__|Channel 3 1-3
__|Channel 4 1-4
__|Channel 5 2-1
__|Channel & 2-2
__|Channel 7 2-3
__|Channel 8 2 -4

MCP-Plus User ’'s Manual



4 Client Server

Signal conditioning (MCP) client connects to the signal-conditioning server

Controlling al the available features, excluding the HW configuration
Ssettings.
Available client features:
e Gain Control.
e Filtration control
e Stimulus Isolation Control.

e Impedance Measurements Control.

4.1 Runningthe Signal Conditioning Client
To run the Signal Conditioning Client application do one of the following:

e Inthe MCP client computer disk top click the MCP client icon.

o Or
Select Start > Program > M CP client.

Once the Signal Conditioning Client is running, verify at the status bar that it is
automatically connected to the server.

The status bar may indicate either of the following:

e Disconnected

e Working

Dizconnected

If the client is disconnected do, the following:

1. Inthe server, select Options->TCP Server Options.

The following window appears:
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TCP Server Options

132 166.0.41

2. Verify that the under Status appears listen... in Connection 1.
If not, click Start.

3. Intheclient select Options> TCP options.

The following window opens:

TCP Cliamt Opthans

[ 1P dxddss | Cornecton | Semice Tue [ Staus
Server IP S — r - -
address | [T N Bliching = St | [ Discomnecied
IREAEL [ HorBlocking =| Sun | [ Disconnecisd
[ r@am R HNonBlocking =] Swan [T Disconneciad
| 127000 | MoerBlocking = | Swn | [ Disconnecied
| 127001 T [ Noerlocking v || Seat | Disconnecied
/|

4. Under |P Address (connection 1), enter the | P address of the server asit
appears at the bottom of the TCP Server Options window.

5. To establish connection, click Start.
6. Under Status, view the client connection status.
7. Select File> Get Server Settings to open the workspace.

4.2 Defining a Workspace

In the following section you will divide the first 4 channels (1-4) in Module 1 and the
channels 5-8 in module 2.

1. Inthe server application, select Setup > Options.

2. Inthe Setup window, in Number of Modules, type 2.
3. InModulein One Window, type 1.

4. Click Save.

The Signal Conditioning main window is as follows:
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5. Inthe Signal Conditioning Client, select File > Get Server Settings at the
application.

6. Verify that the Signal Conditioning application restarts with the server's
workspace.

7. Close module 1.
8. Select File > Save to save the settings to the workspace.

9. Inthe server application, close module 2.

Each user can control the channels independently without distracting the other

user.
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4.3 MCP TCP server commands for mat

Command format:
a= ItemType & ItemNamel=ItemVall &...& ItemName#=ItemVa#

Following isalist of supported commands for MCP TCP server:

Li st of ItenType:

MCP_SET Set channel conditioning paraneters
MCP_GET Get channel conditioning paraneters
MCP_STI MULATOR Change paraneters for stinulus
MCP_I SOLATOR Change paraneters for |sol ator

MCP_ | MPEDANCE Set nodul e to node | npedance

MCP_M XER Change paraneters for m xer

Li st of |temNanes:

MCP_CHANNEL_NUMBER

MCP_MCODULE_NUMBER

MCP_PAR_ONOFF

MCP_PAR_NOTCH

MCP_PAR_GAI N

NCP_PAR_LP

NCP_PAR_HP

NCP_PAR_OFFSET

MCP_SET_VALUE

If aparameter is not present then it should not be changed.
Port number is 8092.

Examples:

Set to “On” channel number 1
a=MCP_SET& MCP_CHANNEL_NUMBER=1& MCP_PAR_ONOFF=1

Set to “On” whole module number 1
a=MCP_SET&MCP_MODULE_NUMBER=1&MCP_PAR_ONOFF=1

Get al current parameters of channel number 1
a=MCP_GET&MCP_CHANNEL_NUMBER=1

Begin stimulation of channel number 1
a=MCP_STIMULATOR&MCP_CHANNEL_NUMBER=1& MCP_PAR_ONOFF=1
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5 Simulation support using the MCP

The MCP supports three modes of switching an el ectrode between recording and stimulation
asfollows:

1. Manual switching at Head stage level using a Start/Stop button

2. Triggered switching at Head stage level using an external TTL pulse.

3. Triggered switching at Stimulus Isolator level using an external TTL pulse with the
option to drop the gain on the other channels.

The following section will instruct you on how to set your system for each one of the modes.

5.1 Manual stimulation according to Start/Stop Button

In this mode the user may select the desired electrode and start/stop stimulation manually by
clicking a start/stop buttons. This mode could be run with AlphaOmega or any other
stimulator/Stimulus I solator.

Run the stimulation
1. Goto Settings>Stimulus and verify that the Stimulus contr ol window opens.

2. Typethedesired electrode number in the select stimulation channel.

STIMULUS CONTROL

Select Stimulation Channel

Feturn Ground

-

Cloze I Start Stop

3. To start stimulation, click the Start Button.

4. To stop the stimulation click the Stop button.

5. To close the window and exit the stimulation, click the close button.
Clicking this button while stimulation stops the stimulation and closes the

Window.
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5.2 Stim/Rec according to an external trigger.

MCP ver. 3.5 or higher includes the option to enable/disable the Stim/Rec trigger and set the
desired Stim channel.

The External Trigger:

Real-Time switching to stimulation or recording is performed when an External TTL Trigger
(digital signal) isreceived. When the signal is High, then the selected channel is switched to
Stimulation mode. When the signal is Low, then the selected channel is switched to
Recording mode.

The external trigger should be connected to the digital I/0O connector 1 (D-type female 25
pin) at the rear panel of the MCP when the digital ground at pin 21 and the stimulation on/off
at pin 22. (See the MCP rear panel view).

LN hil!lll:lh

é"m i-tr

|, e «iﬁwﬁﬂ-

MCP rear panel view.

Digital 1/0 1

Using the On/Off Stimulation Switch
Note: User should verify that the MCP hasthe correct software version.
See the M CP softwar e upgrade instructions at appendix B.
1. Install MCP application 3.5

2. Select menu item Setup>Options.
The following window opens:

Mumber of modules {1 - 543 |2

Madule in one window : |2
Audio Installed: JMDdUla' Mine v]

[~ Motch Installed
I lzolator Installed
IV Stim/Bec Switch Installed
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3. Check the box “Stim/Rec Switch Installed” to enablethe TTL trigger to control
switching from recording to stimulation.
4. Click “OK” to close the window.

5. Select menu item Settings> Stimulus.
The following window opens:

STIMULUS CONTROL fgj

Select Stimulation Channel : 1

Feturn Ground
v ceording to Stim/Rec switch
[ Shut DFf during stirmulus

Cloze | Start Stop

Check the box “According to Stim/Rec switch”.

Choose desired channel for stimulation and press “Start” button.

Circle of On/Off button, of the selected channel at the MCP’s main window, turns

from green to pink color.

9. Now connection to external trigger signal is enabled and switching between
Stimulation and Recording modes is possible. When the mode is switched then
On/Off button turns from pink to red color.

10. To stop stimulation, press the “Stop” button in the “Stimulus Control” diaog.

© N

To select adifferent channel, press the “Stop” button in “Stimulus Control” dialog and
change Stimulation channel number.
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5.3 Stim/Rec — Recor ding between stimulation .
(only with AlphaOmega stimulator).

The stimulation-recording feature enables the researcher to stimulate with one electrode and
to record with another between the stimulation periods.

The following should be available in order to be able to setup and run this feature:

v Alpha Stimulus | solator.

v" MCP (with the suitable Eproms).

v 2TTL Generators.

v" Waveform of the desired stimulation current.

5.3.1 Pulses and wave synchronization

Without any relation to the source of the TTL pulses and of the waveform, they aways
should stand with the following time definitions to obtain the desired synchronization:

t_pre_stimulation |.qj[q | = >
S T
1
waveform :

|
1
| —| t_post_stimulation
|

o 4P t post_gain
t_pre_gain 4 T
: ;
1 ]
StimRec IN —— :
I ;
1 ]
1 ]
1 ]

Stimulation Recording
MCP |
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The following table summarizes the synchronization time values between the TTL’s and the

waveform pulses.

Timeperiod Related Pulse Related actions Valueor
Name pulse explanation and results Tolerance
Actions
t pre stimulation | Wave Thetime Before > 125us
form before t pre_stimulation
stimulation (us) connect the
pulse. Isolator to the
load.
t post_stimulation | Wave Thetime After >0
form after t post_stimulation
stimulation (ns) disconnect
pulse the Isolator from
the load
t pre gan Stim/Rec | Thetime In thisthe MCP > 100us
IN before dropthegainin
connecting the recording
the Isolator to | channel
the load
t post_gain Stim/Rec | Thetime In thistime the -100us<
IN before or MCPreturnsthe |t post gain
after previous gain as < 100us
disconnecting | before
the I solator
from the
load.
t_duration Wave Thetime t_duration >
form between two 800us
pulses.

According to the definitions in the above table we may have recording after 800usec of the
stimulation pulse up to 225usec before the next stimulation pulse. See the following figure:

Current Monitor

800us

Recording electrode A/\f'M/\/\N\/\A/\/\J

J*

J*

Recording electrode vs. stimulation pulse
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5.3.2 Setup Configurations

The stimulation-recording feature can be run in two deferent configurations depending on the
TTL’s and the waveform source.

» Alphamap or Alphalab Pro generates the TTL pulses and the waveform.
» Externa devices generate the TTL pulses and the waveform.

5.3.3. Connecting the wave form, the TTL’s source, and the load to the
Stimulator.

=—> Needed Accessories:

D N N N NN

Stimulator Isolator

AlphaMap/Alphalab or user’s TTL’s source device.
Load Cable.

Two BNC cables.

Control cable.

Connect the control cable between the Digital 1/0 2 at the MCP and the M CP
control connector at the stimulator.

Connect the WAVE IN at the stimulator to the Analog Output of the
AlphaMap/Alphalab pro or to your waveform source, by one of the BNC cables.

Connect D.out1l at the Digital 1/0 of the Alphalab/Alphamap or the TTL source
device to the MCP Digital 1/0 1 connector at the MCP.

Connect D.out?2 at the Digital 1/0 of the AlphaL Ab/AlphaMap or the TTL source
deviceto the STIM/REC IN connector | the stimulator.

Connect the Load cable to the stimulator according to the colors of the REF,
+STIM, -STIM.

Connect the power cable to the power supply connector at the stimulator.
Verify that the STIM/REC switchisin “O” status.

Connect the load cable to the load according to the following diagram”

Note: regarding the Draw on the next page, you may use a resistor of 10KQ instead of the load for
training. In this case the red and green should connected to a one side of the resistor and the black to

the otherside.
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A.S.Isolato

Black Red Green H.S
| Yellow
3 T Gree 1
L STIM+ Green ® feen Cht Black
Red
STIM-
Ma 1| STIM- LOAD
- I |
GND
Build in part
GND

5.4 Running the stimulation

This section will instruct you on how to run the stimulation when the TTL’s and the waveform are
from the AlphalLab or when they are used from an external device.

5.4.1 Thewaveform and TTL’sare generated by the Alphlab pro
The waveform and TTL’sin the Alphalab can be generated in two ways:

1. From the AlphaMap.
2. From apredefined user text file read by the AlphaMap.

5.4.1.1 Wave form produced by the Alphamap

1. Turnonthe Alphalab or the AlphaMap and the MCP.
2. Activate the signal conditioning and the Data Acquisition applications.
3. Define the pulses shape in the data acquisition application, as follows:

e (Goto Options> Output parametersadvanced... the following window opens:

Output parameters @
- - T emplates:
Time or Sampling
[microsec] H Fiate [kH=] [o | -
= 1. T otal Stimulus Duration [mSec]: [0 EhanoolnblStsinnns Fie-
or Choose the template frssh
— |
Total Mo of bursts T T e
2 Burst lnterval [mSec]: o
Add Lo templates Help
3 Mo of pulses in burst o
Remowe the template
4. FPulse lnterval [mSec]: [u] B St (Mo of praloco—=23
5 Phasel Amplitude [ o | pai== pualses
E.FPhasel Duration [mSecl: o ! l5 ’ X F21—24
=] =
7.Phase Interval [mSecl [ = e e

8 FhazeZ Amplitude ] (5]
S iannel we

9. FPhase2 Duration [mSec]: [u] = T 1 B = B o
Defaults | ok | cancel | sppw | 5
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e Define the desired waveform parameters. (For testing you may select the default).
See the AlphaMap manual.

e Click “Ok” to close the window and save the changes.

4. Check and activate the Stim/Rec and I solator options in the MCP.
e Goto Setup > options. The following window opens:

Mumber of modules {1 - B4} |2
Module in one window : |8

Audio Installed: | Modular Mixer >

v Match Installed
W |zalator Installed
v Stim/Rec Switch Installed

Cancel

e Check thelsolator Installed and the Stim/Rec Switch installed checkboxes.
e Click “OK?”.

Verify that the Stim/Rec switch isin the “I” status at the stimulator 1solator.
Turn on the stimulator Isolator.
In the signal conditioning application, go to settings > | solator.

oo s

Stimulus Isolator
Control ;

Channel ; Cancel

v According bo Stim/Fec switch

v Shut O during shimulus 100 micro
0] mby

™= 108w - jl 10 mad

Select the desired channel for stimulation.

Click the status button so it becomes “on”.

Verify that the green led on the isolator is on.

Start the acquisition at the AlphaMap.

Click the start stimulus button at the AlphaMap tool bar.
The current will flow when the Stim/rec pulse is high.
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54.1.2 Waveform produced from a predefined text file.

1. Activate the MCP and the AlphaMap applications.
2. Inthe MCP go to Setup > options.

Mumber of modules {1 - B4} |2

Module in one window : |8
Audio Installed: IM':":'ULE" Miner ']

v Match Installed
W |zalator Installed
W Stim/Fec Switch Installed

Cancel

e Check the Stim/rec switch Installed and the | solator I1nstalled check boxes.
e Click ok to close the window.

3. Goto settings > I solator. The following window opens.

Stimulus Isolator
Control ;

Channel ; Cancel

W According to Stim/Rec switch

W Shut O during shimulus 100 micro
01 mby

=108 - jl 10 ma

Verify that the according to stim/Rec and the Shut off during stimulus are checked.
Type the desired channel number in the Channel edit field.

Select the desired current range and value.

Click the Status button and make it “on”.

Verify that the Stim/Active LED in the stimulator isolator is on.

4. Inthe AlphaMap go to Run > Load stimulus pattern. The following window opens.
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Stimulus Pattern file

X

Stimulug Pattern File Path:

|C:'\Stim Files'stimalphalmega. k=t Browse |

Uszing DA channel [O: O pausze

Switch: Use stimulus digital data

Stimulusz time=210, Block Size=42800, Repeat=1
Delay 500

Stimulusg time=210, Block Size=4200, Repeat=1
Delay 500

[apli I RN CN R

= ! e

Pattern contains & block s and will be started from row(block] no.1.To change beginin
row double click on the desired row or tepe itg number and press Enter. 1

] Stop ] Eoas

5. Click Browse. The following window opens:

Open Stimulus Patern File E]E]
o - @ e

Look ir;

(IC3 stim

File: name: stirmdlphallmenga.tx
Files of tupe: 1Stimulus Fatern File [*.zpt) Lj Cancel

Browse and select the desired stimulation file.

6. Select the desired data column to start from.

7. Start Acquisition.

8. To start the stimulation click the Stimulus button or the Start pattern button at the tool
bar.

9. To stop the Stimulation click the Stop button.

10. To close the Application click the Close button.

11. You may restart the stimulation while the Acquisition is running by clicking the Start
pattern button at the tool bar without opening the stimulus pattern file window.
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The stimulation text file format

Following is the stimulation text file of the above section with complete explanation.
Each parameter is bolded with it’s value the same as it appears in the file. Right to it appears
an explanation.
Channel 1D: AcceptsthevaluesOor 1.
0 It determents the analog output Dac. In AlphaMap and AlphalLab it
should Be 0.

Switching Flag: AcceptsthevaluesO or 1.

1 Indicates if the Stim/Rec time sharing pulses are enabled, thisis used
when using an Alpha Omega Stimulator,
If flag=1 then the Digital_Out_Put_Data must be filled with data.

Repeat Count: Minimum valueis 1, maximum is 50000.
5 Number of timesthe analog_Out_Put_Data would be repeated .

Sampling Rate: Minimum value is 20 maximum value is 100000.

50000 sampling rate to be used for the D/A, note that possible sampling
rates values are those acceptable by DAP according to the
sampling time.

OutputTime is 1000000/SamplingRate; OutputTime should be an
even number and Minimum OutputTimeis 10.

Thisvalue is truncated to the nearest possible value. For
example,

16000 is truncated to 16129.

Block size: Minimum valueis 1 maximum value is 200000.
50 Represents the number of samples placed in the analog_Out_Put_Data and
Digital_Out_Put_Data parameters

Analog_Out_Put_Data:

00000000000000032767 32767 32767 32767 32767 32767 32767 32767 32767
32767 -32768 -32768 -32768 -32768 -32768 -32768 -32768 -32768 -32768 -32768 -32768 -
32768 -32768 -32768 -327680000000000

Maximum value is 32767 and minimum value is—-32768.

This block contains the analog data that would be played by the D/A at the output.
The quantity of data should be equal to the Block size.

Let us assume that the output voltage that we want to be played is S.
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=>» The vaue that should beis 32767*S/5.

Digital_Out_Put_Data:
00111111333333333333333333333333333333332222220000

Accepts the values 0,1,2, and 3.
Each value indicates the Dig.outl and Dig.Out2 status at the output. Thisisfor controlling
the AlphaOmega stimulator isolator when recording between stimulation.

Please see the following table:

Dig.Out 1 valueat the | Dig.Out2 value at the
Value : :
output (logic value) output (logic value)
0 Low Low
1 High Low
2 Low High
3 High High

Delay Time: represents delay between blocks in milliseconds.
2000

MCP Command :
a=MCP_SET& MCP_CHANNEL_NUMBER=0& MCP_PAR_ONOFF=0& MCP_PAR _

NOTCH=1& MCP_PAR_GAIN=145

Represents commands that could be sent to the MCP through TCP.
Please refer to the Alpha omega TCP protocol Document for the commends details.
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5.4.2 Thewaveform and TTL’sare generated by external devices

1. Activate the MCP and the Alphamap Applications.
2. Perform steps 2& 3 from the previous section.
3. Start the Waveform and the TTL’s pulses on the external device.

Note: The TTL ’s should stand with the timing definitions. See pulses and wave syncronization
section
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6 Troubleshooting

6.1 General

The following section discusses problems that may arise while operating the M CP-
Plus, their possible causes, and the troubleshooting procedures that can be carried out
by the user. If none of these procedures resolve the problem, contact your service
representative.

6.2 No power

Possible Cause Troubleshooting Procedure

Wall socket not live Plug another electrical device into the wall socket to
verify that the socket islive.

Power cord is not Make sure that the power line cord is seated firmly in

installed properly the mains receptacle

Blown (AC) fuse Unplug the power line cord from the mains
receptacle.

Use a screwdriver to pry open the line filter
access door (ref. to Rear Panel p.11)

Replace the blown fuse and realign to correct 110V /
220V.

If only one of the DC suppliesis not supplied (you can check that on one of input or
output connectors) identify which one +5V, +12V, -12V then turn off the system,
unplug the power cord from the mains socket, and unscrew the fixing screws of the
power supply module (in the Modular MCP-Plus). On the supply board there are four
fuses F5: 5V, F6: 5V, F4: +12V, F3: -12V. Replace the blown fuse.

If none of the above helps to restore power contact your service representative.

Note: In addition to the four fuses mentioned above there are two additional fuses
F1: -12V, F2: +12V, these fuses supply the power for the Head Stage Pre-Amplifiers.

6.3 Power Supply Unit Malfunction

Test the voltage at the input sockets to determine a possible malfunction of the power
supply unit. While the input is connected to one socket, insert atester in the other.
Thetest should indicate readings of -12V, +12V, and +5V. Readings may vary to
within 10% of these figures. Readings other than these indicate a problem in the
power supply unit. If so contact your service representative. To test for amalfunction
in the floating Head Stage power supply unit, proceed as follows:

e Check input receptacles with a probe to detect the reception of the signal. If a
signal is not detected, inspect the fuses behind the Head Stage Control on the
Rear Panel (ref. to Rear Panel p.11). To inspect these fuses, remove the covering
of the Head Stage Power unit. The fuses are marked (F3, F4). Replace the fuse(s)
if necessary.

e |f thefusesarein working order, check for again or filter malfunction (see
below).
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6.4 Channe Malfunction

If achannel failsto respond, check that the External Shutoff or Remote Control In
has not been activated.

6.5 Gain or Filtering Malfunction

If an error is detected in the signal at any of the analog outputs, the user can apply a
known signal (Sine wave is recommended) to the Input. The user can check
changing the amplitude and frequency of the input signal and selecting different
channels, gains, and cutoff frequencies for every output module. Gain or filter
malfunctions can originate in a specific Output Module, in the Input Control Module

or in the Head Stage. Contact your service representative if a malfunction is detected.

6.6 Faulty Communication with PC

Possible Cause Troubleshooting Procedure

Communication cable Check that the communication cableis

not connected firmly seated in the 9-pin plug at the
Rear panel of the M CP-Plus and in the
PC RS232 card.

M CP-Plusis not Switch on the M CP-Plus ensure that the

switched on red LED on the Control Panel islit.

Incorrect RS232 channel | Choose a different channel (the options

was sel ected are COM1 - COM4).

Another system s Make sure that the other system has the

connected to the same capability to work in thismode, if so

RS232 channel ensure that the system is on.

PC RS232 card error Change the RS232 card.

Malfunction in the Contact your service representative.

M CP-Plus Control

Module
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6.7 Frequently Asked Questions

Q) How do | connect the electrodes to your preamplifier?

A) The red wires labeled 1-4 should be connected to the positive (input) end of the
electrode. The Yellow and black wire Labeled “G” and “-*“ should be connected
together and clamped using an alligator clip to the ground on the test subject.

Q) How do | connect stimulation?

A) Depending on the stimulation source you are using there should be two wires, positive
lead and negative or ground. The positive lead from the stimulator should be
connected to the green wire on the back of the preamplifier. The ground can be
connected to the animal.

Q) How do | measure impedance?

A) From the M CP software press the bar at the bottom of each moduleto “I.M. ON”
should come on aswell asagreen circle. Afterwards, connect the BNC output for
each channel into an oscilloscope and measure the voltage peak-to-peak. 1 Volt=1
MQ of impedance. Repeat measurement for al channels.

Q) How can | set multiple channels with the same gain and filter settings in the MCP?
A) After setting the desired parameters in one channel, go to the “Edit” menu and select
“copy channel” then select “paste to al” or “past module.”

Q) What happens to the gain settings after | turn off the PC?

A) The MCP will always keep the last setting used before closing the software. In
addition, you could save the settings into a configuration file that you will open each
time.

Q) After installing the MCP setup, every time | am trying to make a change in the MCP
software | get the message: “Check that the MCP RS232 cable is connected”
A) Change the serial port number in the MCP software.

Q) Isit possible to have unfiltered output?
A) Yes, the MCP output can be filtered or unfiltered.

Q) Can | split asingle channel into two outputs (i.e. for the purpose of having spikes and
LFP for each channel)?
A) We can supply you with a splitter cable that splits every channel to two channels.

Q) | have some noise problems. | can see the noisein the MCP output even if | ground
all the preamplifier inputs.

A) In order to pin point the problem and find the source of the noise:
- Change the MCP location. Place it away from electrical devices that may affect it.
- Check your Ground Loop.

Q) | have an internal mixer. How do | select a channel to hear sound output?
A) In the menu bar go to Settings, choose the audio mixer option and then choose
the channel you want to hear by selecting it.

MCP-Plus User 's Manual 48



Appendix A
Alpha Stimulus | solator

The new Alpha Stimulus Isolator introduces revolutionary flexibility by providing the

researcher with many features that were previously not supported by other
stimulators.

The Alpha Stimulus Isolator can invert any supplied waveform into current.
It has awide Band Width, 100KHz on load of 10K, and provides an
important tool to perform stimulations in many patterns.

The useful feature of Current Monitor enables the researcher to have
information about the current in the load in real time.

Alpha Stimulus | solator Rear Panel

.............-.-..I.....l'.-

...I........l....*“..l....l'..

..l.....’.-.....-QU...........
..'..........l.......'..-..l

v v '
Power Supply STIMRIC | 15-pinMCP

IN control for BNC current  BNC waveformin
stimulator monitor out

Alpha Stimulus Isolator Front Panel

. Tele, C< Stimulus
. e Is@lator
@ el '
Alpha Omgga ..:.:.:.:.:.:.:.:.. ‘
Black Green Red GreenlLed On/Off Indicator
Connector Connector Connector Stlm Current is
Ref (GND)  Stim (-) Stim (+) active
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Alpha Stimulus I solator Technical Specifications

Input
Signal type: Arbitrary analog waveform.
Frequency range: 0-100 KHz
Signal range: +5V

Input impedance: 10 KQ min.
Safeinput voltage:  + 30V pp
Connector: BNC

Output (tested with sine and squar e wave)

Bandwidth +3dB: 0-100 KHz at 10Kohm
Bandwidth +3dB: 0-25KHz at 100Kohm
Bandwidth +3dB: 0-3KHz a 1Mohm
Max output Voltage Range: +/-125V or +/-175V
Offset Current: +0.01% of full range
Noise RTO 100KHz BW: 0.1% of full range
Output current ranges:

5uA - 100uA

100uA-1mA

1mA- 6mA
Output Current Accuracy: 1%
Slew Rate: 40 V/psec (Load=10K)

20 V/usec (Load=100K)
2 V/usec (Load=1M)

|=6mA, load = 10Kohm, Vout=60V
I=1mA, load = 100K ohm, Vout=125V

| solation
2500VRMS

Control
Software control through the AO Multi Channel Processor through a 15 pin
D-type connection.

Indicators
ON/OFF LED
Stimulus active LED
Current monitor output through a BNC connector, the CM have the same
bandwidth of the output.
Range 100uA =5V in CM
Range 1mA =5V inCM
Range 10mA(6mA) =5V in CM
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Weight
0.75Kg

Dimensions
250 X 145 X 90 mm

Power Supply

AC/DC that supplies the isolated parts,
+/-12V that supplies the non isolated parts.
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Appendix B

Installation Instruction for MCP Upgrade

Older versions of MCP may be upgraded to include the On/Off Stimulation Switch
feature.
In order to perform upgrade please follow the below steps:

Install PLM chips

1. Turn off power of MCP box and unplug power cable.
2. Open MCP box cover.
3. Carefully remove PLM chips U14 and U15 from MCP control card.

MSB-U14

MSB - U15

4. Install new PLM chips. Please note, every bank haslabel MSB or LSB. The
same |abels there are on every chip. Every chip should be inserted
accordingly. Polarity of chipsisimportant — please note small notch on chip
and its bracket.

5. Turn power on and check that abuzz signal is not heard. If abuzz signal is
heard it means that PLM chips are not inserted properly.

6. Turn power off. Close MCP box cover.
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/. ALPHA OMEGA

U.S. Office: Toll Free 1-877-919-6288 Fax 1-877-471-2055
Home Offlce P.O. Box 810, Nazareth Illit 17105 Israel. Tel. 972-4-6563-327 Fax: 972-4-6574-075

Registration Card

Surname: First Name:
Institute:

Address:

Postal Code:

City:
Country:
Phone No.:

Fax:

E-mail;

System: No. Of Channels:
Serial Number(s):
Software Version:
Purchase Date:

Problem Description:
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